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Administratorhandbuch

Die folgenden Anweisungen gelten fiir Administratoren an Standorten mit dem Lizenztyp Lizenz fiir
gleichzeitig angemeldete Benutzer fiir IBM® SPSS Statistics 22. Mit dieser Lizenz konnen Sie IBM SPSS
Statistics auf beliebig vielen Computern installieren. Allerdings hdngt die Anzahl der Benutzer, die die
Anwendung gleichzeitig ausfiihren kénnen, davon ab, fiir wie viele Personen die Lizenz erworben wur-
de.

Vorbereitungen

Sie benétigen Thren Autorisierungscode. Mit dem Autorisierungscode konnen Sie eine Lizenz fiir den
Concurrent License Manager abrufen. Der Concurrent License Manager steuert die Lizenz fiir gleichzei-
tig angemeldete Benutzer und erméglicht den Endbenutzern die Ausfiihrung von IBM SPSS Statistics.

Sie sollten separate Anweisungen zum Abrufen Thres Autorisierungscodes erhalten haben. Wenn Sie den
Autorisierungscode nicht finden kénnen, wenden Sie sich an den Kundendienst. Rufen Sie hierzu die Sei-
te [http: / /www.ibm.com /software/analytics /spss/support/clientcare.html] auf.

Fiihren Sie die folgenden Schritte aus, um sicherzustellen, dass Sie die Lizenz fiir gleichzeitig angemelde-
te Benutzer ordnungsgemafs eingerichtet haben:

1. Installieren Sie den Concurrent License Manager. Der Concurrent License Manager ist ein Dienst-
programm, das Endbenutzern die Lizenz fiir gleichzeitig angemeldete Benutzer bereitstellt. Sie konnen
den Lizenzmanager auf einem beliebigen Computer in Threm Netz speichern. Ublicherweise handelt
es sich dabei um einen Server, an den Desktop-Computer angeschlossen werden konnen. Weitere In-
formationen finden Sie im Thema |, Installieren des Concurrent License Managers” auf Seite 2]

2. Lizenzieren Sie das Produkt. Mit diesem Vorgang erhilt der Lizenzmanager die fiir die Ausgabe der
Lizenzen erforderlichen Informationen. Weitere Informationen finden Sie im Thema
[, Produktlizenzierung” auf Seite 5

3. Testen Sie den Concurrent License Manager. Sie sollten den Lizenzmanager testen, um sicherzustel-
len, dass er Lizenzen bereitstellt. Weitere Informationen finden Sie im Thema
[Lizenzmanagers” auf Seite 8|

4. Installieren Sie IBM SPSS Statistics auf den lokalen Desktop-Computern. Sie oder Ihre Endbenut-
zer fithren die vollstindige Installation auf den Desktop-Computern durch. Wahrend der Installation
kann der Endbenutzer den Computer angeben, auf dem der Lizenzmanager ausgefiihrt wird. Wenn
ein Endbenutzer versucht, IBM SPSS Statistics zu starten, fordert das Produkt bei diesem Lizenzmana-
ger einen Lizenzcode an. Wenn eine Lizenz verfiigbar ist, wird IBM SPSS Statistics gestartet. Weitere
Informationen finden Sie im Thema |, Installieren des Produkts auf lokalen Desktop-Computern” auf|

Fiir die Installation sind keine administrativen Schritte erforderlich. Sollten jedoch Probleme auftreten,
finden Sie unter |,,Verwa1ten der Lizenz fir gleichzeitig angemeldete Benutzer” auf Seite 14| weitere Infor-
mationen.

Erstellen eines Images

Sie konnen ein Image der Software erstellen, indem Sie den Lizenzmanager installieren und das Produkt
anschlieffend auf einem lokalen Desktop installieren, der zum Erstellen eines Images verwendet wird. Er-
stellen Sie nach Bedarf Images von zusatzlichen Computern.

Citrix- und Terminaldienste

Sie kénnen die Anwendung IBM SPSS Statistics auf dieselbe Art auf dem Citrix- bzw. Terminaldienst-Ser-
ver installieren und den Benutzern zugénglich machen, auf die Sie andere Anwendungen fiir Windows
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installieren und zugénglich machen. Beachten Sie jedoch, dass der Lizenzmanager selbst nicht in einer
virtualisierten Umgebung installiert werden kann. Er muss auf einem physischen Computer installiert
werden.

Gemischte Lizenzierung

IBM SPSS Statistics unterstiitzt gemischte Lizenzierungsumgebungen (eine Kombination aus lokalen Li-
zenzen fiir berechtigte Benutzer und Lizenzen fiir gleichzeitig angemeldete Benutzer) nur in einge-
schranktem Mafle. In einer typischen Umgebung werden sdmtliche Lizenzen entweder lokal oder iiber
den Concurrent License Manager verwaltet. Wenn das Hauptprodukt beispielsweise tiber den Concurrent
License Manager lizenziert ist, werden Zusatzmodule ebenfalls iiber den Concurrent License Manager li-
zenziert.

Eine gemischte Lizenzierung ist nur moglich, wenn das Hauptprodukt iiber den Concurrent License Ma-
nager lizenziert und die Zusatzmodule auf dem Computer des Endbenutzers mit licenseactivator lizenziert
werden. Installieren Sie IBM SPSS Statistics mit einer Lizenz fiir gleichzeitig angemeldete Benutzer, um
diese Art der gemischten Lizenzierung einzurichten. Verwenden Sie dann licenseactivator auf dem Compu-
ter des Endbenutzers, um die Zusatzmodule zu lizenzieren. Weitere Informationen zu licenseactivator fin-
den Sie unter|, Verwenden von licenseactivator zur automatischen Installation einer Lizenz” auf Seite 6]

IBM SPSS Statistics unterstiitzt das umgekehrte Szenario nicht, bei dem das Hauptprodukt lokal und die
Zusatzmodule iiber den Concurrent License Manager lizenziert werden.

Installieren des Concurrent License Managers

Bevor Endbenutzer IBM SPSS Statistics auf ihrem Desktop-Computer installieren, miissen Sie den Con-
current License Manager installieren. Dieses Dienstprogramm ist ein fortlaufend ausgefiihrter Service
oder Damonprozess, der tiblicherweise auf einem Computer im Netz installiert wird. (Sie haben auch die
Moglichkeit, ihn auf mehreren Computern zu installieren, wobei Sie redundante Lizenzmanager einrich-
ten miissen. Weitere Informationen finden Sie im Thema|,Einrichten von redundanten Lizenzservern” auf]
) Der Concurrent License Manager wird nicht auf den Desktop-Computern installiert.

Immer wenn ein Endbenutzer eine der Lizenz fiir gleichzeitig angemeldete Benutzer unterliegende IBM
SPSS-Anwendung startet, fordert die Anwendung eine Lizenz vom Lizenzmanager an. Dieses Dienstpro-
gramm gibt Lizenzen bis zu einer festgelegten Anzahl gleichzeitiger Endbenutzer aus, die sich aus der
von Thnen erworbenen Lizenz ergibt. Wenn diese Anzahl erreicht ist, werden weitere Anfragen nach Li-
zenzen zurlickgewiesen. Wenn Sie feststellen, dass Endbenutzern haufig Lizenzen verweigert werden, er-
kundigen Sie sich bei dem fiir Sie zustdndigen Héandler nach einer Lizenz fiir eine grofierer Anzahl
gleichzeitiger Benutzer.

Lizenzmanager sind auf einer separaten DVD/CD verfiigbar. Sie kénnen auch als elmage heruntergela-
den werden.

Anmerkung: Sie miissen den Concurrent License Manager auf einem physischen Computer installieren.
Die Installation des Lizenzmanagers in einer virtualisierten Umgebung wird nicht unterstiitzt.

Anmerkung: Der Lizenzmanager zeichnet die Anzahl aktiver Endbenutzersitzungen sowie Informationen
zu diesen einzelnen Sitzungen in einer Protokolldatei auf, die Sie dann zur Fehlerbehebung bei Verbin-
dungsproblemen heranziehen konnen. Weitere Informationen finden Sie im Thema

[Protokollinformationen” auf Seite 15|

Mehrere Betriebssysteme
Die Plattform, auf der der Concurrent License Manager ausgefiihrt wird, muss nicht mit der Plattform

iibereinstimmen, auf der der Client aktiv ist. Zum Beispiel kann ein Linux-Lizenzmanager Lizenzen fiir
Windows-Clients bereitstellen.
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Verwalten des Lizenzmanagers

Der Lizenzmanager wird mithilfe des Lizenzmanageradministrators verwaltet, der nur fiir Windows ver-
fligbar ist. Beachten Sie deshalb, dass Sie mindestens einen Windows-System benétigen, auf dem der Li-
zenzmanageradministrator installiert ist.

Systemanforderungen

Der Computer, auf dem der Concurrent License Manager installiert werden soll, muss folgende Anforde-
rungen erfiillen:

e Prozessor mit mindestens 500 Mhz
¢ Mindestens 128 MB RAM

Wichtig: Wenn auf dem Lizenzserver eine Firewall lauft, miissen Sie Port 5093 fiir UDP 6ffnen. Andern-
falls kénnen die Client-Computer keine Lizenz vom Lizenzmanager abrufen. Wenn Sie dariiber hinaus re-
dundante Lizenzserver verwenden, miissen Sie Port 5099 fiir UDP 6ffnen, damit die Lizenzserver unterei-
nander kommunizieren kénnen.

Durchfiihren eines Upgrades fiir den Lizenzmanager

Wenn Sie eine frithere Version des Lizenzmanagers installiert haben, miissen Sie die folgenden Schritte
durchfiihren:

1. Wechseln Sie in das Verzeichnis, in dem Sie den alten Lizenzmanager installiert haben.
2. Kopieren Sie die Datei Iservrc. Windows: Suchen Sie im Verzeichnis winnt.

3. Speichern Sie die Datei Iservrc an einem sicheren Ort.
4

. Falls Benutzer Pendlerlizenzen ausgecheckt haben, stellen Sie sicher, dass diese Lizenzen wieder ein-
gecheckt werden. Informationen zum Abrufen einer Liste der ausgecheckten Lizenzen finden Sie im
Thema |, Konfigurieren von Pendlerlizenzen” auf Seite 17}

5. Fahren Sie den Lizenzmanager herunter. Weitere Informationen finden Sie im Thema
[Stoppen des Lizenzmanagers” auf Seite 19

6. Deinstallieren Sie den alten Lizenzmanager. Weitere Informationen finden Sie im Thema [, Deinstallie
fren des Lizenzmanagers” auf Seite 20|

7. Installieren Sie den neuen Lizenzmanager. Informationen zum Installieren unter Windows finden Sie
im Thema |, Installieren des Lizenzmanagers unter Windows”| Informationen zum Installieren unter
UNIX/Linux finden Sie im Thema [, Installieren des Lizenzmanagers unter UNIX/Linux” auf Seite 4}
Weitere Informationen zum Installieren unter Mac OS finden Sie unter |, Installieren des Lizenzmana-
lzers unter Mac OS” auf Seite 4

8. Kopieren Sie die gespeicherte Datei Iservrc in das Verzeichnis, in dem Sie den neuen Lizenzmanager
oder das Unterverzeichnis winnt des Installationsverzeichnisses unter Windows installiert haben.
Wenn Sie den Standardspeicherort unter Windows akzeptiert haben, wechseln Sie in den Ordner C:\
Programme\IBM\SPSS\Concurrent Licensing Tools\ <Version>\License Manager.

Installieren des Lizenzmanagers unter Windows

Anmerkung: Sie miissen Concurrent License Manager auf einem physischen Computer installieren. Die
Installation des Lizenzmanagers in einer virtualisierten Umgebung wird nicht unterstiitzt.

Anmerkung: Unter Windows Vista oder 7 miissen Sie das Installationsprogramm als Administrator aus-
fihren. Wenn Sie aufgefordert werden, eine Installationsdatei zu starten, klicken Sie mit der rechten

Maustaste auf die Datei und wahlen Sie Als Administrator ausfiihren.

Anmerkung: Vergewissern Sie sich, dass auf dem Computer, auf dem Sie die Installation durchfiihren,
Java installiert ist.
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1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des Netz-
computers ein, auf dem der Lizenzmanager ausgefiihrt werden soll. Suchen Sie nach dem Windows
Installer fiir den Lizenzmanager und starten Sie ihn von der DVD/CD.

ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, kénnen Sie mit einem Archivierungsprogramm
wie WinZip alle Dateien im entsprechendem elmage extrahieren. Starten Sie die Datei des Installati-
onsprogramms fiir Ihr Betriebssystem.

2. Folgen Sie den am Bildschirm angezeigten Anweisungen.
Installieren des Lizenzmanagers unter UNIX/Linux

Anmerkung: Sie miissen den Concurrent License Manager auf einem physischen Computer installieren.
Die Installation des Lizenzmanagers in einer virtualisierten Umgebung wird nicht unterstiitzt.

1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des Netz-
computers ein, auf dem der Lizenzmanager ausgefiihrt werden soll. Suchen Sie nach der Lizenzmana-
gerdatei fiir Ihr Betriebssystem.

ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, wechseln Sie zu dem Speicherort, an den Sie die
Datei heruntergeladen haben.

Entpacken Sie die Datei des Lizenzmanagers.
Fiihren Sie die extrahierte TAR-Datei aus.

Folgen Sie den am Bildschirm angezeigten Anweisungen.

ok~ wbd

Installieren Sie den Lizenzmanageradministrator auf einem Windows-System. Weitere Informationen
finden Sie im Thema |,Installieren des Lizenzmanageradministrators”}

6. Weitere Informationen zum Starten des Lizenzmanagers finden Sie unter |,Starten und Stoppen des|
[Lizenzmanagers” auf Seite 19|

Installieren des Lizenzmanagers unter Mac OS

1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des Netz-
computers ein, auf dem der Lizenzmanager ausgefiihrt werden soll. Suchen Sie nach der Lizenzmana-
gerdatei fiir Ihr Betriebssystem.

ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, wechseln Sie zu dem Speicherort, in das Sie die
Datei heruntergeladen haben.

Doppelklicken Sie auf die ZIP-Datei des Lizenzmanagers, um den Inhalt der Datei zu entpacken.
Doppelklicken Sie auf das entpackte Installationsprogramm des Lizenzmanagers.
Folgen Sie den am Bildschirm angezeigten Anweisungen.

ok 0N

Installieren Sie die Lizenzmanagertools auf einem Windows-System. Weitere Informationen finden Sie
im Thema |, Installieren des Lizenzmanageradministrators”}

6. Weitere Informationen zum Starten des Lizenzmanagers finden Sie unter |,Starten und Stoppen des|
[Lizenzmanagers” auf Seite 19

Installieren des Lizenzmanageradministrators

Der nur fiir Windows verfiigbare Lizenzmanageradministrator wird fiir die Verwaltung des Lizenzmana-
gers verwendet. Je nach Betriebssystem miissen Sie diese Anwendung gegebenenfalls manuell installieren.

* Windows. Der Lizenzmanageradministrator wird automatisch auf dem gleichen System installiert, auf
dem Sie auch den Lizenzmanager installiert haben. Sie kénnen die Installation auch auf einem anderen
Windows-System vornehmen, wenn Sie den Lizenzmanager remote verwalten mochten.

¢ Andere Betriebssysteme. Wenn Sie den Lizenzmanager auf einem Nicht-Windows-System installiert
haben, miissen Sie die Lizenzmanagertools auf einem Windows-System installieren.
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1. Legen Sie die DVD/CD mit den parallelen Lizenzierungstools in das DVD/CD-Laufwerk des Netz-
computers ein, auf dem der Lizenzmanageradministrator ausgefiihrt werden soll. Suchen Sie nach
dem Windows Installer fiir den Lizenzmanageradministrator und starten Sie ihn von der DVD/CD.
ODER:

Wenn Sie eine elmage-Datei heruntergeladen haben, kénnen Sie mit einem Archivierungsprogramm
wie WinZip alle Dateien im entsprechendem elmage extrahieren. Starten Sie die Installationsdatei des
Lizenzmanageradministrators.

2. Folgen Sie den am Bildschirm angezeigten Anweisungen.

Produktlizenzierung

Klicken Sie nach dem Abschluss des Hauptteils der Installation auf Fertigstellen, um den Lizenzautorisie-
rungsassistenten zu starten. Mit dem Lizenzautorisierungsassistenten konnen Sie eine Lizenz fiir IBM
SPSS Statistics anfordern. Bei anderen Betriebssystemen miissen Sie die Lizenz nach der Installation des
Lizenzmanagers iiber die Eingabeaufforderung installieren.

Wenn Sie jetzt keine Lizenz beziehen, konnen Sie IBM SPSS Statistics fiir einen bestimmten Zeitraum fiir
die temporédre Verwendung aktivieren, in dem das Produkt von einer begrenzten Anzahl an Personen
verwendet werden kann. In IBM SPSS Statistics sind alle Zusatzmodule aktiviert. In IBM SPSS Statistics
Developer ist nur das Kernsystem aktiviert. Nach Ablauf des Zeitraums fiir die tempordre Verwendung,
der mit der ersten Nutzung des Produkts beginnt, kann IBM SPSS Statistics nicht mehr ausgefiihrt wer-
den. Daher sollten Sie so schnell wie moglich einen Lizenzcode anfordern. Sie miissen entweder eine Li-
zenz einholen oder eine Aktivierung fiir die tempordre Verwendung durchfiihren, um IBM SPSS Statistics
zu verwenden.

Anmerkung: Lizenzen sind mit einem Sperrcode an die Hardware des Netzcomputers gebunden. Wenn
Sie den Netzcomputer oder die zugehdrige Hardware austauschen, benédtigen Sie einen neuen Sperrcode
und miissen bei Ihrem Vertriebsbeauftragten einen neuen Autorisierungscode anfordern. Wenn Sie die in
der Lizenzvereinbarung angegebene zuldssige Anzahl an Autorisierungen tiberschritten haben, rufen Sie
die Seite |http: / /www.ibm.com /software/analytics/spss/support/ clientcare.htmll auf, um Unterstiitzung
durch das Kundenbetreuungsteam anzufordern. Beachten Sie auch, dass Ihr Autorisierungscode fiir eine
bestimmte Anzahl an CPUs generiert wurde. Wenn Sie {iiber eine groflere Anzahl an CPUs als im Autori-
sierungscode angegeben verfiigen, erhalten Sie eine Warnnachricht und das Produkt funktioniert 30 Tage
nach der Autorisierung nicht mehr.

Wichtig: Die Lizenz reagiert auf Anderungen der Systemzeit. Wenn Sie die Systemzeit dndern miissen
und dann das Produkt nicht mehr ausfiihren konnen, fordern Sie Unterstiitzung durch das Kunden-
betreuungsteam iiber die Seite |http://www.ibm.com/software/analytics/spss/support/ clientcare.html|
an.

Verwenden des Lizenzautorisierungsassistenten (nur Windows)

Hinweis: Wenn Sie Windows Vista verwenden, werden Sie gegebenenfalls aufgefordert, sich als Administ-
rator anzumelden. Ohne die entsprechenden Berechtigungsnachweise kénnen Sie den Lizenzautorisie-
rungsassistenten nicht ausfiihren.

1. Wenn Sie den Lizenzautorisierungsassistenten nicht wahrend der Installation starten oder den Lizenz-
autorisierungsassistenten abbrechen, bevor eine Lizenz erworben wurde, konnen Sie ihn durch Aus-
fiihrung der Datei law.exe starten, die Sie im Installationsverzeichnis des Lizenzmanagers finden. Un-
ter Windows Vista oder 7 miissen Sie das Installationsprogramm als Administrator ausfiihren. Klicken
Sie mit der rechten Maustaste auf die Datei law.exe und wihlen Sie Als Administrator ausfiihren aus.

2. Wenn Sie dazu aufgefordert werden, wahlen Sie Produkt jetzt lizenzieren aus. Wenn Sie stattdessen
eine Aktivierung fiir die tempordare Verwendung durchfiihren mochten, finden Sie unter
ffiir die temporire Verwendung” auf Seite 7| weitere Informationen.

3. Geben Sie im entsprechenden Dialogfenster einen oder mehrere der Autorisierungscodes ein.
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Sie sollten separate Anweisungen zum Abrufen Ihres Autorisierungscodes erhalten haben. Wenn Sie
den Autorisierungscode nicht finden konnen, wenden Sie sich an den Kundendienst. Rufen Sie hierzu
die Seite |http:/ /www.ibm.com /software/analytics/spss/support/clientcare.html| auf.

Der Lizenzautorisierungsassistent sendet Ihren Autorisierungscode iiber das Internet an IBM und ruft
Ihre Lizenz automatisch ab. Wenn sich Ihr Computer hinter einem Proxy befindet, klicken Sie auf Proxy-
Einstellungen konfigurieren und geben Sie die entsprechenden Einstellungen an.

Wenn der Autorisierungsvorgang nicht erfolgreich endet, werden Sie aufgefordert, eine E-Mail zu senden.
Geben Sie dann an, ob die E-Mail iiber Ihr Desktop-E-Mail-Programm oder iiber eine webbasierte E-Mail-
Anwendung versendet werden soll.

* Wenn Sie sich fiir die Desktopoption entschieden haben, wird eine neue Nachricht mit den entspre-
chenden Informationen automatisch erstellt.

* Wenn Sie sich fiir die webbasierte Option entschieden haben, miissen Sie zuerst eine neue Nachricht in
Ihrem Web-basierten E-Mail-Programm erstellen. Kopieren Sie dann den Nachrichtentext aus dem Li-
zenzautorisierungsassistenten und fiigen Sie ihn in Thre E-Mail-Anwendung ein.

Versenden Sie die E-Mail und reagieren Sie auf die Eingabeaufforderung des Lizenzautorisierungsassis-
tenten. Die E-Mail wird praktisch sofort verarbeitet. Klicken Sie auf Lizenzcode(s) eingeben, um erhalte-
ne Lizenzcodes einzugeben. Wenn Sie den Lizenzautorisierungsassistenten bereits geschlossen haben, star-
ten Sie ihn neu und wihlen Sie Jetzt mein Produkt lizenzieren. Fiigen Sie im Bereich "Codes eingeben"
den erhaltenen Lizenzcode hinzu und klicken Sie auf Weiter, um den Vorgang abzuschliefsen.

Installieren einer Lizenz lGiber die Eingabeaufforderung

Sie haben zwei Moglichkeiten zur Installation iiber die Eingabeaufforderung. Sie konnen mithilfe von [i-
censeactivator automatisch eine Lizenz aus dem Internet abrufen oder Sie konnen mithilfe von echoid
manuell eine Lizenz beziehen.

Verwenden von licenseactivator zur automatischen Installation einer Lizenz

Der Computer, auf dem Sie die Lizenz installieren, muss mit dem Internet verbunden sein. Andernfalls
miissen Sie die Lizenz manuell installieren. Weitere Informationen finden Sie im Thema |,Manuelles Ins{
[tallieren einer Lizenz” auf Seite 7|

1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.

2. Offnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-
nagers. Dies ist das Verzeichnis, in dem Sie den Lizenzmanager installiert haben, nicht das Installations-
verzeichnis von IBM SPSS Statistics. Wenn Sie den Standardspeicherort unter Windows akzeptiert ha-
ben, wechseln Sie in den Ordner C:\Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\
License Manager.

3. Nur unter Windows. Wechseln Sie in das Unterverzeichnis winnt.

4. Normalerweise sind Sie im Besitz eines Autorisierungscodes. Im einfachsten Fall geben Sie Folgendes
an der Eingabeaufforderung ein. (Weitere Details zur Verwendung der Befehlszeile finden Sie unten.)

licenseactivator <Autorisierungscode>
Dabei ist <Autorisierungscode> Ihr Autorisierungscode.

Es sollte eine Nachricht angezeigt werden, dass die Lizenz erfolgreich hinzugefiigt wurde. Andernfalls
notieren Sie sich den Fehlercode und versuchen Sie, die Lizenz manuell zu installieren. Weitere Informati-
onen finden Sie im Thema [,Manuelles Installieren einer Lizenz” auf Seite 7

Bei Verwendung von licenseactivator wird das Produkt lizenziert und eine Protokolldatei in das Pro-
duktverzeichnis geschrieben. Der Name der Protokolldatei ist licenseactivator_<Monat>_<Tag>_<Jahr>.log.
Wenn Fehler auftreten, konnen Sie gegebenenfalls der Protokolldatei weitere Informationen entnehmen.
Diese Informationen sind auch dann hilfreich, wenn Sie sich an den IBM Support wenden.
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Verwenden von licenseactivator mit Autorisierungscodes

licenseactivator wird iiblicherweise mit einem oder mehreren Autorisierungscodes verwendet, die Sie beim
Kauf des Produkts erhalten haben. Geben Sie den gesamten Text in einer einzigen Zeile ein.

[PROXYPORT=Proxy-Portnummer] [PROXYUSER=Proxy-Benutzer-ID] [PROXYPASS=Proxy-Kennwort]
* Mehrere Autorisierungscodes werden durch Doppelpunkte (:) getrennt.

* Die Proxy-Einstellungen sind optional, aber sie sind unter Umstédnden nétig, wenn sich Thr Computer
hinter einem Proxy befindet. Welche Proxy-Einstellungen benétigt werden, hiangt von der jeweiligen
Proxy-Konfiguration ab. Moglicherweise sind alle erforderlich.

PROXYHOST
Der Servername oder die IP-Adresse des Proxy-Hosts

PROXYPORT
Die Portnummer fiir die Internetverbindung tiber den Proxy

PROXYUSER
Falls erforderlich, die Benutzer-ID fiir den Proxy.

PROXYPASS
Falls erforderlich, das Kennwort fiir die Benutzer-ID

Verwenden von licenseactivator mit Lizenzcodes

Eventuell hat Ihnen IBM eine Lizenz gesendet.

* Mehrere Lizenzcodes werden durch Doppelpunkte (:) getrennt.

* Bei Verwendung von Lizenzcodes stellt licenseactivator keine Verbindung zum Internet her, sodass Sie
keine Proxy-Informationen angeben miissen.

Manuelles Installieren einer Lizenz

1. Melden Sie sich mit demselben Benutzerkonto an wie bei der Installation des Lizenzmanagers.

2. Offnen Sie eine Eingabeaufforderung und wechseln Sie in das Installationsverzeichnis des Lizenzma-
nagers. Beachten Sie, dass dies der Ordner ist, in dem Sie den Lizenzmanager installiert haben, nicht
das Installationsverzeichnis von IBM SPSS Statistics. Wenn Sie den Standardspeicherort unter Win-
dows akzeptiert haben, wechseln Sie in den Ordner C:\Programme\IBM\SPSS\Concurrent Licensing
Tools\<Version>\License Manager.

3. Nur unter Windows. Wechseln Sie in das Unterverzeichnis winnt.

4. Rufen Sie den Sperrcode fiir den Server-Computer ab. Geben Sie an der Eingabeaufforderung echoid
(Windows) oder ./echoid (andere Plattformen) ein.

5. Rufen Sie unsere regionale Niederlassung an oder senden Sie eine E-Mail an spsscs@us.ibm.com und
teilen Sie IBM den Sperrcode und Ihren Autorisierungscode mit. IBM wird Ihnen anschlieflend einen
Lizenzcode oder eine Datei mit dem Lizenzcode bereitstellen.

6. Verwenden Sie licenseactivator zur Eingabe des bzw. der Lizenzcodes.

Aktivieren fur die temporare Verwendung

Wenn Sie die Lizenz nicht installiert haben, kénnen Sie IBM SPSS Statistics fiir die tempordre Verwen-
dung aktivieren.

1. Wenn Sie iiber Installationsdatentrédger verfiigen, stellen Sie sicher, dass sich die DVD/CD im DVD/
CD-Laufwerk befindet. Wenn Sie ein elmage heruntergeladen haben, 6ffnen und/oder extrahieren Sie
den Inhalt des eImage.

2. Starten Sie die Anwendung WImAdmin. Weitere Informationen finden Sie im Thema |, Starten der An{
fwendung WImAdmin” auf Seite 14}
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3. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben Subnet
Servers. Wenn der Lizenzmanagerserver nicht angezeigt wird, geben Sie den Computer an, indem Sie
im Menii "Edit" die Option Defined Server List auswéhlen.

4. Klicken Sie mit der rechten Maustaste auf den Netzcomputer, auf dem der Lizenzmanager ausgefiihrt
wird, und wahlen Sie dann die folgenden Befehle aus:

Add Feature > From a File > To Server and its File

Hinweis: Wenn Sie To Server auswihlen anstatt To Server and its File, werden die Informationen zur
tempordren Verwendung im Arbeitsspeicher gespeichert. Diese Informationen gehen beim Neustart
des Netzcomputers verloren.

5. Geben Sie im Dialogfeld "Open" den Pfad D:\Windows\Administration\Licensing\
NeworkLicenseManager\lservrc.temp ein. Dabei steht D fiir das Laufwerk Ihres Installationsdatentra-
gers. Wenn D nicht das Laufwerk Ihres Installationsdatentrédgers ist, geben Sie den entsprechenden
Laufwerkbuchstaben ein. Wenn Sie ein elmage heruntergeladen haben, geben Sie
<eImage>\Administration\Licensing\NeworkLicenseManager\lservrc.temp ein. Dabei steht <elmage>
fiir den Speicherort, an dem Sie die elmage-Dateien gedffnet/extrahiert haben.

6. Klicken Sie auf OK, wenn die Anwendung IThre Lizenz anzeigt. Informationen zur Anzeige der Li-
zenzdetails finden Sie unter |,,Anzeigen der Details zu einer Lizenz” auf Seite 15|

Hinzufligen einer Lizenz

Eventuell mochten Sie zu einem spéteren Zeitpunkt eine Lizenz hinzuftigen. Der Vorgang beim Hinzufi-
gen einer Lizenz ist identisch mit der Installation der originalen Lizenz.

Anzeigen der Lizenz

Sie konnen Ihre Lizenz fiir gleichzeitig angemeldete Benutzer (einschlieslich der Anzahl der Benutzer) in
der Anwendung WImAdmin anzeigen. Informationen zur Anwendung WImAdmin und die Besonderhei-
ten beim Anzeigen der Lizenz finden Sie unter [, Verwalten der Lizenz fiir gleichzeitig angemeldeté]

[Benutzer” auf Seite 14

Testen des Lizenzmanagers

Um sicherzustellen, dass der Lizenzmanager die Lizenzen korrekt bereitstellt, sollten Sie ihn testen.

1. Wenn Sie den Lizenzmanageradministrator nicht auf einem anderen System installiert haben, installie-
ren Sie ihn auf einem Windows-System, auf dem der Lizenzmanager, den Sie testen mdchten, nicht
lauft. Weitere Informationen finden Sie im Thema |, Installieren des Lizenzmanageradministrators” auf]

2. Installieren Sie einen weiteren Lizenzmanager auf einem Windows-System, auf dem der Lizenzmana-
ger, den Sie testen mochten, nicht ausgefiihrt wird. Weitere Informationen finden Sie im Thema
ftallieren des Lizenzmanagers unter Windows” auf Seite 3}

3. Starten Sie die Anwendung WImAdmin. Weitere Informationen finden Sie im Thema [, Starten der An-
wendung WImAdmin” auf Seite 14|

4. Fiigen Sie den fernen Server des Lizenzmanagers hinzu, den Sie testen mochten. Weitere Informatio-
nen finden Sie im Thema |, Hinzufiigen eines Servers” auf Seite 14

5. Zeigen Sie die Lizenzen auf dem fernen Server an. Weitere Informationen finden Sie im Thema
fzeigen der Details zu einer Lizenz” auf Seite 15|

Wenn Sie die Lizenzen anzeigen konnen, ist der Lizenzmanager bereit, dass lokale Desktop-Computer an-
geschlossen werden. Sie konnen mit der Installation des Produkts auf lokalen Desktop-Computern begin-
nen. Wenn Sie die Lizenzen nicht anzeigen kénnen, {iberpriifen Sie die vorhergehenden Schritte, um si-
cherzustellen, dass der Lizenzmanager korrekt installiert wurde.
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Installieren des Produkts auf lokalen Desktop-Computern

Anmerkung: Die Verbindung mit dem Concurrent License Manager iiber VPN wird nicht offiziell unter-
stiitzt.

Fiir die lokale Installation des vollstdindigen Produkts auf den Computern der Endbenutzer stehen Ihnen
zwei Optionen zur Verfiigung: Sie konnen auf jedem Computer eine manuelle Installation durchfiihren
oder eine Anwendung wie Systems Management Server (SMS) verwenden, um die Installation auf Win-
dows-Computern durchzufiihren. Sie haben aufierdem die Mdoglichkeit, eine unbeaufsichtigte Installation
unter Mac und Linux durchzufiihren.

Durchfiihren einer manuellen Installation auf einem lokalen Desktop-Computer

1. Stellen Sie die Installationsmedien zur Verfiigung. Laden Sie das elmage fiir das Produkt herunter
und extrahieren Sie die Dateien auf einem freigegebenen Netzlaufwerk. Wenn Sie tiber Installationsda-
tentrdger verfiigen, erstellen Sie die benétigte Anzahl von Kopien der DVD/CD oder speichern Sie
die entsprechenden Dateien auf einem freigegebenen Netzlaufwerk.

2. Kopieren Sie die Installationsanweisungen und bereiten Sie die Lizenzinformationen vor. Erstellen
Sie die bendtigte Anzahl von Kopien der Installationsanweisungen fiir das Produkt. Die Installations-
anweisungen stehen auf der Download-Site bzw. im Falle von physischen Installationsmedien im Ver-
zeichnis /Documentation/<Sprache>/InstallationDocumentsauf der DVD/CD zur Verfligung. Suchen Sie
nach den Anweisungen, die Ihrem Lizenztyp entsprechen. Nach der Installation miissen die End-
benutzer die IP-Adresse oder den Namen des Netzcomputers eingeben, auf dem der Concurrent Li-
cense Manager ausgefiihrt wird. Tragen Sie diese Informationen an der dafiir vorgesehenen Stelle am
Anfang der Anweisungen ein, bevor Sie diese kopieren.

3. Verteilen Sie die Installationsunterlagen und -medien an die Endbenutzer. Verteilen Sie die
Installations-DVD/CDs (oder die heruntergeladene Datei oder geben Sie den Netzpfad des Installati-
onsdatentrdgers bekannt), die Installationsanweisungen und die Lizenzinformationen an die Endbe-
nutzer, die auf den Computern nach Bedarf manuell installieren kénnen.

Ubertragen der Installation unter Windows auf lokale Desktop-Computer

Da IBM SPSS Statistics-Installationen mit Microsoft Windows Installer (MSI) kompatibel sind, konnen Sie
die Installation automatisch auf die Desktop-Computer der Endbenutzer iibertragen.

Ubertragen einer Installation an Windows-Computer

Das Ubertragen einer Installation ist eine Methode fiir die Fernverteilung von Software an eine beliebige
Zahl von Endbenutzern, ohne dass die Benutzer aktiv werden miissen. Sie konnen eine vollstindige Ins-
tallation von IBM SPSS Statistics auf die Computer der Endbenutzer unter Windows {iibertragen. Die fiir
die automatische Ubertragung der Installation verwendete Technologie muss die MSI 3,0-Engine oder ho-
her unterstiitzen.

Anmerkung: Die Ubertragung einer Installation steht fiir Mac und Linux nicht direkt zur Verfiigung.
Stattdessen konnen Sie eine unbeaufsichtigte Installation durchfithren. Weitere Informationen finden Sie
im Thema [, Ausfiihren einer unbeaufsichtigte Installation auf Mac- und Linux-Computern” auf Seite 13|

Deinstallation einer fritheren Version

Wenn Sie die automatische Ubertragung in ein Verzeichnis durchfiihren, in dem eine friihere Version von
IBM SPSS Statistics installiert wurde, muss die alte Version deinstalliert werden. Sie konnen die Deinstal-
lation ebenso wie eine Installation iibertragen. Weitere Informationen finden Sie im Thema
[Ubertragung einer Deinstallation” auf Seite 13|
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Eigenschaften fiir automatisch libertragene Installationen

Nachfolgend finden Sie die Eigenschaften, die fiir automatisch iibertragene Installationen verwendet wer-
den konnen. Bei allen Eigenschaften wird zwischen Grofs- und Kleinschreibung unterschieden. Werte
miissen in Anfithrungszeichen angegeben werden, wenn sie Leerzeichen enthalten.

Tabelle 1. Eigenschaften fiir automatisch (bertragene Installationen.

Eigenschaft

Beschreibung

Giiltige(r) Wert(e)

INSTALLDIR

Das Verzeichnis, in dem IBM SPSS
Statistics auf dem Desktop-Computer
des Endbenutzers installiert werden
sollte. Diese Eigenschaft ist optional.
Wird sie nicht angegeben, wird der
Standardwert C:\ Programme\IBM\
SPSS\Statistics\22 verwendet.

Ein giiltiger Pfad, beispielsweise C:\
Statistics.

LICENSETYPE

Der Lizenztyp. Bei diesem Wert wird
zwischen Grof- und Kleinschreibung
unterschieden.

Network

LSHOST

Die IP-Adresse oder der Name des
Computers bzw. der Computer im
Netz, auf dem bzw. denen der
Concurrent License Manager ausge-
fiihrt wird.

Eine oder mehrere giiltige IP-Adres-
sen oder Namen der Computer im
Netz. Mehrere Adressen oder Namen
miissen durch Doppelpunkte ge-
trennt werden (z. B.
Server:Server2:Server3).

DISABLE_COMMUTE

Inaktiviert die Pendlerlizenzfunktion
auf dem Desktop-Computer des
Endbenutzers. Wenn diese Eigen-
schaft angegeben wird, werden auf
dem Desktop-Computer keine Ver-
kniipfungen fiir Pendlerlizenzen ins-
talliert. Weitere Informationen zu
Pendlerlizenzen finden Sie unter
,Konfigurieren von Pendlerlizenzen”|

auf Seite 12]

1 gibt an, dass die Pendlerlizenzen
inaktiviert sind.

COMMUTE_MAX_LIFE

Die maximale Anzahl von Tagen, fiir
die ein Endbenutzer eine
Pendlerlizenz auschecken kann. Wei-
tere Informationen finden Sie im The-
ma |, Konfigurieren von|
[Pendlerlizenzen” auf Seite 17}

Eine Zahl zwischen 1 und 30.

INSTALLPYTHON

IBM SPSS Statistics - Essentials for
Python installieren. Umfasst Python
Version 2.7, das IBM SPSS Statistics -
Integration Plug-in for Python und
eine Reihe von Python-
Erweiterungsbefehlen, die Moglich-
keiten bieten, die tiber die mit
integrierten SPSS Statistics-Prozedu-
ren bereitgestellten Moglichkeiten
hinausgehen. Weitere Informationen
finden Sie unter "Integration Plug-in
for Python" im Hilfesystem.

1 gibt an, dass IBM SPSS Statistics -
Essentials for Python installiert wird.
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Tabelle 1. Eigenschaften fir automatisch (bertragene Installationen (Forts.).

Eigenschaft Beschreibung Giiltige(r) Wert(e)
HELPCHOICE Ein Wert, der die Hilfesprache angibt. | ALL (Alle Sprachen)
Sie kénnen die Hilfe in allen Spra- de (Deutsch)
chen oder neben Englisch in einer en (Englisch)

bestimmten Sprache installieren. Der |es (Spanisch)

Wert ist ALLE oder ein Code, der die | fr (Franzosisch)

Sprache angibt. Der Standard ist die |it (Italienisch)
Landereinstellung oder die durch die |ja (Japanisch)

Eigenschaft TRANSFORMS angegebene | ko (Koreanisch)

Sprache. Weitere Informationen fin- | p1 (Polnisch)

den Sie im Thema |,,Automatische| ru (Russisch)

Ubertragung der Installation auf ein| |zh CN (vereinfachtes Chinesisch)
nicht enelisches System” auf Seite 12} zh_TW (traditionelles Chinesisch)

Die Codes werden in der Spalte mit
den giiltigen Werten aufgelistet. Die
dem Code zugewiesene Sprache er-
scheint in Klammern neben dem

Code.
COMPANYNAME Der Name Thres Unternehmens. Eine beliebige Zeichenfolge.

MSI-Dateien

Die Datei IBM SPSS Statistics 22.msi befindet sich im Verzeichnis Windows\SPSSStatistics\<Architektur>
auf der DVD/CD, wobei <Architektur> fiir 32bit oder 64bit steht. Nachdem Sie die Software heruntergela-
den haben, miissen Sie den Inhalt des elmage entpacken, um auf die MSI-Datei zugreifen zu konnen.

Beispiel fiir die Befehlszeile
Nachfolgend finden Sie eine Befehlszeile zur automatischen Ubertragung einer Produktinstallation. Geben
Sie den gesamten Text in einer einzigen Zeile ein.

MsiExec.exe /i "IBM SPSS Statistics 22.msi" /qn /L*v Protokolldatei.txt
INSTALLDIR="C:\Statistics" LICENSETYPE="Network" LSHOST="mylicserver"

Automatisches Ubertragen der Installation mithilfe von SMS
Die grundlegenden Schritte fiir die Verwendung von Systems Management Servers (SMS) fiir die automa-
tische Ubertragung (Push) von IBM SPSS Statistics sind folgende:

1. Kopieren Sie das entsprechende Unterverzeichnis im Verzeichnis Windows\SPSSStatistics\
<Architektur> auf der DVD/CD in ein Verzeichnis auf einem Netzcomputer. Wenn Sie die Software
heruntergeladen haben, miissen Sie den Inhalt des elmage zunéchst entpacken.

2. Bearbeiten Sie die Datei IBM SPSS Statistics 22.sms im kopierten Verzeichnis. Bearbeiten Sie mithilfe
eines Texteditors den Wert von "CommandLine", indem Sie die entsprechenden Eigenschaften hinzu-
fligen. Eine Liste der verfiigbaren Eigenschaften finden Sie unter [, Eigenschaften fiir automatisch iiber-|
[tragene Installationen” auf Seite 10} Stellen Sie sicher, dass Sie die richtige MSI-Datei in der Befehlszei-
le angeben.

3. Erstellen Sie ein Paket aus der Datei IBM SPSS Statistics 22.sms und verteilen Sie das Paket an die
Desktop-Computer der Endbenutzer.

Verwenden von Gruppenrichtlinie oder einer @hnlichen Technologie zur automati-

schen Ubertragung der Installation

1. Kopieren Sie das entsprechende Unterverzeichnis im Verzeichnis Windows\SPSSStatistics\
<Architektur> auf der DVD/CD in ein Verzeichnis auf einem Netzcomputer. Wenn Sie die Software
heruntergeladen haben, miissen Sie den Inhalt des eImage zunéchst entpacken.
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2. Mit einer Anwendung wie ORCA konnen Sie die Eigenschaftstabelle in der entsprechenden Datei IBM
SPSS Statistics 22.msi unter dem kopierten Ordner bearbeiten. ORCA ist Teil des Windows 2003 Server
SDK, das Sie unter |http:/ /www.microsoft.com/downloadd finden, indem Sie nach dem SDK suchen.
Eine Liste der Eigenschaften, die in die Eigenschaftstabelle aufgenommen werden konnen, finden Sie
unter |, Eigenschaften fiir automatisch {ibertragene Installationen” auf Seite 10} Achten Sie darauf, dass
Sie die richtige MSI-Datei verwenden.

3. Erstellen Sie ein Paket aus der bearbeiteten Datei IBM SPSS Statistics 22.msi und verteilen Sie das Pa-
ket an die Desktop-Computer der Endbenutzer.

Automatische Ubertragung der Installation auf ein nicht englisches System

Sie kénnen sie ohne zusétzliche Spezifikation auf ein nicht englisches System {iibertragen. Allerdings sind
dann die Installationsanweisungen (bei der Ubertragung einer interaktiven Installation), die Benutzer-
schnittstelle und die Hilfe auf Englisch. Die Anwender kénnen nach der Installation die Benutzerschnitt-
stellensprache umstellen, es steht jedoch keine lokalisierte Hilfe zur Verfiigung.

Sie konnen die Eigenschaft TRANSFORMS verwenden, um eine der MST-Dateien anzugeben, die auf der
DVD/CD oder im heruntergeladenen elmage vorhanden sind. Die MST-Datei stellt sicher, dass der Instal-
lationsassistent, die Benutzerschnittstelle und die Hilfe in der spezifizierten Sprache erscheinen. MST-Da-
teien sind nicht verfiigbar, wenn Sie IBM SPSS Statistics heruntergeladen haben. Benutzer miissen die
Sprachpakete fiir die lokalisierte Hilfe manuell installieren und die Benutzerschnittstellensprache in dem
Produkt manuell dndern.

Die Eigenschaft TRANSFORMS ist ein Parameter fiir MsiExec.exe. Das folgende Beispiel verwendet die Eigen-
schaft TRANSFORMS zur automatischen Ubertragung einer franzésischen Installation. Der Installationsassis-
tent erscheint auf franzdsisch, die Benutzerschnittstelle erscheint auf franzosisch und die Hilfe wird auf
franzosisch installiert. (Sie kénnen die Sprache der Hilfefunktion auch mit der Eigenschaft HELPCHOICE
iiberschreiben. Weitere Informationen finden Sie im Thema [, Eigenschaften fiir automatisch iibertragene|
[Installationen” auf Seite 10}) Geben Sie den gesamten Text in einer einzigen Zeile ein.

MsiExec.exe /i "IBM SPSS Statistics 22.msi" /qn /L*v Protokolldatei.txt
INSTALLDIR="C:\Statistics" LICENSETYPE="Network" LSHOST="mylicserver" TRANSFORMS=1036.mst

Die folgenden Sprach-MST-Dateien befinden sich im Verzeichnis Windows\SPSSStatistics\ <Architektur>
auf der DVD/CD, wobei <Architektur> fiir 32bit oder 64bit steht. Wenn Sie ein elmage heruntergeladen
haben, befinden sich diese Dateien im Stammverzeichnis der entpackten elmage-Dateien.

Tabelle 2. MST-Sprachdateien.

Sprache MST-Datei
Englisch 1033.mst
Franzosisch 1036.mst
Deutsch 1031.mst
Italienisch 1040.mst
Japanisch 1041.mst
Koreanisch 1042.mst
Polnisch 1045.mst
Russisch 1048.mst
Spanisch 1034.mst
Vereinfachtes Chinesisch 2052.mst
Traditionelles Chinesisch 1028.mst
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Automatische Ubertragung einer Deinstallation

Hinweis: Wenn Sie den Deinstallationsbefehl automatisch tibertragen, gehen die Anpassungen der Endbe-
nutzer verloren. Wenn bestimmte Benutzer ihre Anpassungen benétigen, konnen Sie diese aus der Vertei-
lung ausschlieffen und sie bitten, das Produkt manuell zu installieren.

Wenn Sie eine Installation einer neueren Version von IBM SPSS Statistics automatisch iibertragen, sollten
Sie gegebenenfalls zuerst eine Deinstallation durchfiihren. Sie kénnen dies im Hintergrund durchfiihren
lassen, indem Sie den folgenden Befehl durch einen Push-Vorgang automatisch iibertragen. Geben Sie den
gesamten Text in einer einzigen Zeile ein.

MsiExec.exe /X{104875A1-D083-4A34-BCAF-3F635B7F8EF7} /qn /L*v Protokolldatei.txt
ALLUSERS=1 REMOVE="ALL"

Dieser Befehl deinstalliert IBM SPSS Statistics 22. In der folgenden Tabelle sind die Deinstallations-IDs
flir diese und frithere Versionen aufgelistet.

Tabelle 3. Deinstallations-IDs fiir IBM SPSS Statistics.

Version | Deinstallations-ID

22.* {104875A1-D083-4A34-BC4F-3F635B7FSEF7}

21.% {1E26B9C2-ED08-4EEA-83C8-A786502B41E5}

20.* {2AF8017B-E503-408F-A ACE-8A335452CAD2}

19.* {06C43FAA-7226-41EF-A05E-9AE0A A849FFE}
{
{
{

18.% C25215FC-5900-48B0-B93C-8D3379027312}
17.0.2 2ECDE974-69D9-47 A9-9EB0-10EC49F8468A}
17.0.1 46B65150-F8A A-42F2-94FB-2729A8 AE5SF7E}

17.0.0
16.* {621025AE-3510-478E-BC27-1A647150976F}

Ausfihren einer unbeaufsichtigte Installation auf Mac- und Linux-Com-
putern

Eine unbeaufsichtigte Installation erfolgt ohne grafische Benutzeroberflache und erfordert keine Eingriffe
seitens des Benutzers. IBM SPSS Statistics enthélt eine Datei mit den Eigenschaften fiir das Installations-
programm, mit der Sie diese Art von Installation auf Mac OS- und Linux-Computern durchfiihren kén-
nen. Die Datei enthilt verschiedene Optionen und Beschreibungen zu diesen Optionen.

Verwendung der Datei "installer.properties”

Die Datei mit den Eigenschaften fiir das Installationsprogramm, installer.properties, befindet sich in /Linux/
Administration oder /MacOS/Administration im Stammverzeichnis der DVD/CD. Wenn Sie ein elmage he-
runtergeladen haben, befindet sich installer.properties im Ordner Administration des elmage.

1. Kopieren Sie die Datei "installer.properties” von der DVD/CD oder vom elmage.

2. Offnen Sie die kopierte Datei in einem Texteditor.

3. Andern Sie die benétigten Eigenschaften. Einige Optionen benétigen einen Zeichenfolgewert, andere
dagegen, die einer Auswahl im Installationsassistenten entsprechen, kénnen auf 0 (aus) oder 1 (an) ge-
setzt werden.

Ausfiuhren einer unbeaufsichtigten Installation

Stellen Sie bei Installationen unter Mac OS sicher, dass die unbeaufsichtigte Installation und nicht die in-
teraktive Installation durchgefiihrt wird. Die unbeaufsichtigte Installation weist die Erweiterung .bin auf
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und kann als elmage heruntergeladen werden. Wenn Sie {iber Installationsdatentrdger verfiigen, befindet
sie sich auf der DVD/CD unter /MacOS/Administration/.

1. Fiihren Sie in einer Terminalanwendung die Installation mit dem Schalter -f aus, gefolgt vom Spei-
cherort der Datei "installer.properties” in Anfithrungszeichen. Unter Mac OS und Linux muss die Aus-
fiihrung als "Root" oder mit dem Befehl sudo erfolgen. Es folgt ein Beispiel unter Linux:

sudo ./setup.bin -f "/root/installer.properties"”

Verwalten der Lizenz fiir gleichzeitig angemeldete Benutzer

Der Lizenzmanager verwaltet die Lizenz fiir gleichzeitig angemeldete Benutzer. Mithilfe der Anwendung
WImAdmin, die die Hauptbenutzeroberflache fiir den Lizenzmanageradministrator ist, konnen Sie den
Lizenzmanager verwalten und Informationen zu den verwalteten Lizenzen fiir gleichzeitig angemeldete
Benutzer anzeigen. Der Lizenzmanageradministrator wird unter Windows automatisch zusammen mit
dem Concurrent License Manager installiert. Wenn Sie einen Lizenzmanager auf einem Nicht-Windows-
System oder einem Remote-Windows-System verwalten, installieren Sie den Lizenzmanageradministrator
auf einem separaten Windows-System. Weitere Informationen finden Sie im Thema |, Installieren des|
[Lizenzmanageradministrators” auf Seite 4}

Hinweis: Weitere Informationen zur Administration finden Sie in der SafeNet-Dokumentation, die zusam-
men mit dem Lizenzmanageradministrator installiert wird. Diese Dokumentation finden Sie im Unterver-
zeichnis Content des Installationsverzeichnisses des Lizenzmanageradministrators (z. B.C:\Programme\
IBM\SPSS\Concurrent Licensing Tools\9.5.0\License Manager Administrator\Content).

Starten der Anwendung WImAdmin

Auf einem Windows-Computer, auf dem der Lizenzmanager installiert ist:

1. Wabhlen Sie folgende Befehle aus dem Menii "Start" von Windows aus: [Alle] Programme > IBM
SPSS Concurrent Licensing Tools - License Manager<Version> > Sentinel RMS License Server Ad-
ministration

Auf einem Windows-Computer, auf dem die Tools fiir den Lizenzmanager installiert sind:

1. Waihlen Sie folgende Befehle aus dem Menii "Start" von Windows aus: [Alle] Programme > IBM
SPSS Concurrent Licensing Tools - License Manager Administrator <Version> > Sentinel RMS Li-
cense Server Administration

Hinzufligen eines Servers

Bevor Sie einen Lizenzmanager verwalten konnen, miissen Sie in der Anwendung WImAdmin einen Ser-
ver dafiir hinzufiigen. Sie haben zwei Optionen, um den Server hinzuzufiigen.

Manuelles Hinzufligen eines Servers
1. Waibhlen Sie die folgenden Befehle aus den Meniis der Anwendung WImAdmin aus:
Edit > Defined Server List

2. Geben Sie in dem Dialogfeld "Defined Server List" den Namen oder die IP-Adresse des Servers ein,
auf dem der Lizenzmanager lduft.

3. Klicken Sie auf Add.
4. Klicken Sie auf OK.

Der Server wird jetzt in den Listen der Server im linken Fensterbereich der Anwendung WImAdmin an-
gezeigt.

Anzeigen einer Liste der Server im Teilnetz

1. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben Subnet
Servers.
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Eine Liste von Servern fiir Lizenzmanager in Ihrem Teilnetz wird angezeigt. Wenn Sie einen bestimmten
Server mit diesem Verfahren nicht finden, fiigen Sie ihn wie oben beschrieben manuell hinzu.

Abrufen von Protokollinformationen

Wenn Endbenutzer beim Abruf von Lizenzen Schwierigkeiten haben, kénnen die Protokolldateien mogli-
cherweise hilfreiche Informationen enthalten. Sie kénnen die Umgebungsvariable LSERVOPTS sowie die
Optionen -f <Traceprotokolldatei> und -1 <Nutzungsprotokolldatei> verwenden, um anzugeben, dass
Protokolldateien erstellt werden sollen. Weitere Informationen zu dieser Umgebungsvariablen und den
zugehorigen Optionen finden Sie in der SafeNet-Dokumentation im Verzeichnis Content des Installations-
verzeichnisses des Lizenzmanageradministrators.

Anzeigen der Details zu einer Lizenz

Sie konnen Details zu Lizenzen anzeigen, die Sie entweder manuell oder iiber den Lizenzierungsassisten-
ten hinzugefiigt haben.

1. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben Lizenzma-
nagerserver, um die Lizenz(en) anzuzeigen.

2. Klicken Sie auf den Namen der Lizenz. Im rechten Fensterbereich werden Details zu der Lizenz ange-
zeigt. Die Lizenzen werden mithilfe von Codes identifiziert. Der erste Teil des Codes verweist auf die
Funktion. Der zweite Teil verweist auf die Version.

Anzeigen der mit den Funktionscodes verkniipften Namen

1. Wechseln Sie iiber eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-
nistrators.

2. Geben Sie Tmshowlic <Server> (Windows) oder ./Imshowlic <Server> (andere Betriebssysteme) ein.
Dabei stellt <Server> den Namen oder die IP-Adresse des Servers dar, auf der Lizenzmanager ausge-
fiihrt wird.

In der Ausgabe werden alle Funktionen nach Produkt und Version in Gruppen geordnet aufgefiihrt, die
auf dem Server verfiigbar sind.

Einrichten von redundanten Lizenzservern

Sie konnen mehrere redundante Lizenzserver einrichten, die dieselben Benutzer unterstiitzen. Mit redun-
danten Servern kénnen Sie Unterbrechungen verhindern, die durch den Absturz eines Servers bedingt
sind. Im Falle eines Serverabsturzes kann ein anderer redundanter Server die Lizenzverwaltung tiberneh-
men.

Zum Aktivieren der Redundanzfunktion benétigen Sie einen speziellen Autorisierungscode. Mit dem im
Lieferumfang der Software enthaltenen Autorisierungscode kann die Redundanzfunktion nicht aktiviert
werden. Achtung: Wenn Sie den der Software beiliegenden Code installieren, kann die Redundanzfunkti-
on nicht mehr verwendet werden. Wenn Sie die Redundanzfunktion aktivieren mochten, fithren Sie die
folgenden vorbereitenden Schritte aus. Wenden Sie sich dann unter spsscs@us.ibm.com oder telefonisch
zwischen 08:30 und 17:00 Uhr Central Time unter +1-800-521-1337 an den Kundendienst. Wenn Sie aufler-
halb Nordamerikas leben, wenden Sie sich an Ihre lokale Niederlassung.

Es muss eine ungerade Anzahl von Servern (mindestens drei) vorhanden sein und die Mehrzahl der Ser-
ver muss jeweils gleichzeitig ausgefiihrt werden. Wenn zum Beispiel drei redundante Lizenzserver exis-
tieren, miissen von diesen zwei ausgefiihrt werden.

Vorbereiten der einzelnen redundanten Lizenzserver

1. Installieren Sie den Lizenzmanager. Weitere Informationen finden Sie im Thema |, Installieren des Con-|
fcurrent License Managers” auf Seite 2|

2. Wechseln Sie iiber eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.
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3. Rufen Sie den Sperrcode fiir die einzelnen Server-Computer ab. Geben Sie an der Eingabeaufforde-
rung echoid (Windows) bzw. ./echoid (anderes Betriebssystem) ein.

4. Notieren Sie den Sperrcode. Sie benttigen den Sperrcode bei der Kontaktaufnahme mit dem Kunden-
dienst oder der lokalen Niederlassung.

5. Wiederholen Sie diese Schritte fiir jeden redundanten Lizenzserver.

Einrichten eines Pools mit redundanten Lizenzservern

1. Wenn auf einem oder mehreren redundanten Lizenzservern ein Lizenzmanager ausgefiihrt wird, be-
enden Sie diesen auf jedem betroffenen Computer.

2. Wahlen Sie die folgenden Befehle aus den Meniis der Anwendung WImAdmin aus:
Edit > Redundant License File
Dadurch wird die Anwendung WrlfTool gebffnet.
3. Waihlen Sie die folgenden Befehle aus den Meniis der Anwendung WrlfTool aus:
File > New
4. Klicken Sie fiir jeden redundanten Lizenzserver auf Add, um jeweils den Hostnamen und die IP-Ad-
resse anzugeben.

5. Ordnen Sie die redundanten Lizenzserver in der Reihenfolge an, in der sie verwendet werden sollen.
Der erste Server in der Liste ist der primére Server.

6. Klicken Sie auf Add License, um die Lizenzen hinzuzufiigen, die Sie vom Kundendienst oder Threr
lokalen Niederlassung erhalten haben. Achten Sie bei mehreren Lizenzen darauf, dass Sie auch wirk-
lich alle hinzugefiigt haben.

7. Klicken Sie auf OK.
8. Klicken Sie abschliefSend auf Done.

Speichern der redundanten Lizenzdatei
1. Wabhlen Sie die folgenden Befehle aus den Meniis der Anwendung WrlfTool aus:
File > Save As

2. Speichern Sie die redundante Lizenzdatei (Iservrlf) an einem leicht zugédnglichen Speicherort. In den
néchsten Schritten miissen Sie die Datei kopieren.

Konfigurieren der redundanten Lizenzserver

1. Kopieren Sie die redundante Lizenzdatei (/servrlf) unter Windows in den Unterordner winnt des Li-
zenzmanagerinstallationsverzeichnisses. Wenn Sie den Standardspeicherort akzeptiert haben, wechseln
Sie in den Ordner C:\Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\License Manager.
Auf anderen Betriebssystemen kopieren Sie die Datei direkt in das Lizenzmanagerinstallationsver-
zeichnis. Es miissen mindestens drei redundante Lizenzserver vorhanden sein.

2. Starten Sie auf allen redundanten Lizenzservern den Lizenzmanager.
Konfigurieren des Computers des Endbenutzers

Wenn ein Endbenutzer das Produkt unter Windows und Linux installiert, gibt der Benutzer alle redun-
danten Server an. Die Namen oder IP-Adressen der Server werden dabei durch Doppelpunkte getrennt
(z. B. Serverl:Server2:Server3). Das Setup-Programm fiigt dann dem Computer des Endbenutzers die erfor-
derlichen Konfigurationsinformationen hinzu. Wenn das Produkt bereits auf den Computern installiert
ist, konnen Sie die folgenden Schritte ausfiihren, um die Konfigurationsinformationen hinzuzufiigen. Sie
koénnen auch zunédchst eine Deinstallation und anschliefiend eine neue Installation iibertragen, bei der alle
Server festgelegt sind. Informationen zum automatischen Ubertragen von Installationen finden Sie unter
|,,Ubertragen einer Installation an Windows-Computer” auf Seite 9| Wenn das Produkt bereits auf den
Computern installiert ist, konnen Sie die folgenden Schritte ausfiihren, um die Konfigurationsinformatio-
nen hinzuzufiigen. Sie kdnnen auch zunichst eine Deinstallation und anschlieffend eine neue Installati-
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on {ibertragen, bei der alle Server festgelegt sind. Informationen zum automatischen Ubertragen von Ins-
tallationen finden Sie unter |, Ubertragen einer Installation an Windows-Computer” auf Seite 9|

1. Offnen Sie die Datei spssprod.inf in einem Texteditor. Unter Windows befindet sich diese Datei auf
dem Desktop-Computer im Installationsverzeichnis des Produkts. Unter Mac OS befindet sich diese
Datei im App-Bundle unter Contents/bin. Unter Linux befindet sich diese Datei im Unterverzeichnis
bin des Produktinstallationsverzeichnisses.

2. Setzen Sie die Zeile fiir DAEMONHOST auf Kommentar. Beispiel:
#DAEMONHOST=serverl

3. Fiigen Sie eine neue Zeile fiir RedundantServers hinzu und setzen Sie den Wert auf die durch Doppel-
punkt getrennten Namen bzw. IP-Adressen der Server. Beispiel:

RedundantServers=serverl:server2:server3

4. Speichern Sie spssprod.inf.

Konfigurieren von Pendlerlizenzen

Mit Pendlerlizenzen konnen Endbenutzer Lizenzen aus dem Lizenzmanager auschecken, sodass sie diese
Lizenzen verwenden konnen, auch wenn sie nicht mit dem Netz verbunden sind. Unter Windows sind
Pendlerlizenzen standardmafig nicht aktiviert. Auf anderen Betriebssystemen sind sie dagegen standard-
maéflig aktiviert. Anweisungen fiir das eigentliche Auschecken der Pendlerlizenz finden sich in den Instal-
lationshinweisen fiir Endbenutzer.

Sie konnen den Prozentsatz der Lizenzen auf dem Lizenzmanagerserver beschranken, die fiir den mobi-
len Zugriff aktiviert werden. Es empfiehlt sich, die Anzahl der Pendlerlizenzen zu beschranken. Damit
wird verhindert, dass sich alle verfiigbaren Lizenzen im mobilen Einsatz befinden. Wenn der angegebene
Prozentsatz an Lizenzen von mobilen Anwendern aufgebraucht wurde, stehen keine weiteren Lizenzen
zur Verfligung, bis die mobilen Lizenzen ablaufen oder wieder eingecheckt werden. Sie konnen auflerdem
die Dauer festlegen, fiir die mobile Lizenzen ausgecheckt werden kénnen. In der Standardeinstellung be-
trdgt die maximale Dauer 7 Tage.

Wichtig: Wenn Sie redundante Lizenzserver mit Pendlerlizenzen verwenden, gestattet nur der primére
Lizenzserver den Benutzern, Pendlerlizenzen aus- und einzuchecken. Bei einem Ausfall des priméren Li-
zenzservers konnen die Benutzer keine Lizenzen ein- und auschecken.

Festlegen des Prozentsatzes der verfligbaren Pendlerlizenzen

1. Erstellen Sie auf dem Lizenzmanagerserver eine Umgebungsvariable mit dem Namen LSERVOPTS. Die-
se Variable wird unter Windows wéhrend der Lizenzmanagerinstallation erstellt, sodass Sie diesen
Schritt nur fiir die anderen Betriebssysteme durchfiihren miissen.

2. Andern Sie den Wert der Umgebungsvariablen LSERVOPTS, indem Sie -com <Prozentsatz> aufnehmen.
Hierbei stellt <Prozentsatz> einen numerischen Wert zwischen 0 und 100 dar, der den Prozentsatz an
Lizenzen angibt, die fiir den mobilen Zugriff verfligbar sind. Mit der Angabe 0 stehen keine Lizenzen
fiir den mobilen Zugriff zur Verfiigung. Dieser Schalter ist unter Windows standardmaéfig enthalten
und auf 0 festgelegt.

3. Starten Sie den Computer neu, auf dem der Lizenzmanager ausgefiihrt wird.
Festlegen der maximalen Zeitdauer fir Pendlerlizenzen

Die maximale Zeitdauer, fiir die die Endbenutzer eine Pendlerlizenz auschecken konnen, wird durch die
Einstellung CommuterMaxLife in der Datei spssprod.inf auf dem Desktop-Computer angegeben. Unter Win-
dows befindet sich diese Datei auf dem Desktop-Computer im Installationsverzeichnis des Produkts. Un-
ter Mac OS befindet sich diese Datei im App-Bundle unter Contents/bin. Unter Linux befindet sich diese
Datei im Unterverzeichnis bin des Produktinstallationsverzeichnisses. Offnen Sie die Datei spssprod.inf und
suchen Sie nach CommuterMaxLife . Legen Sie den Wert dieser Option auf die maximale Anzahl von Tagen
fest, fiir die die Endbenutzer eine Pendlerlizenz auschecken konnen. Der Wert sollte eine Zahl zwischen 1
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und 30 sein. Sie konnen diesen Wert auch festlegen, wenn Sie die Installation automatisch tibertragen.
Weitere Informationen finden Sie im Thema |,Ubertragen einer Installation an Windows-Computer” auf]|

Hinweis: Diese Funktion arbeitet mit einer Datums-, nicht mit einer Zeitangabe. Wenn Sie zum Beispiel
die Option CommuterMaxLife auf einen Tag setzen und dann eine Lizenz um 9.00 Uhr auschecken, wird
diese Lizenz nicht vor Mitternacht des Folgetages wieder eingecheckt. Auch wenn also CommuterMaxLife
auf einen Tag eingestellt ist, behélt der Benutzer die Lizenz tatsachlich 39 Stunden lang.

Abrufen einer Liste der ausgecheckten Lizenzen in der Befehlszeile

Sie konnen ermitteln, welche Benutzer Lizenzen ausgecheckt haben.

1. Wechseln Sie tiber eine Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanageradmi-
nistrators.

2. Geben Sie Ismon<Server> (Windows) oder ./1smon <Server> (andere Betriebssysteme) ein. Dabei stellt
<Server> den Namen oder die IP-Adresse des Servers dar, auf der Lizenzmanager ausgefiihrt wird.
Sie konnen den Namen des Lizenzservers auslassen, wenn Sie nur die ausgecheckten Lizenzen fiir
den Server "localhost" anzeigen mochten.

Abrufen einer Liste der ausgecheckten Lizenzen in der Anwendung WimAdmin

Sie kénnen ausgecheckte Lizenzen auch in der Anwendung WImAdmin anzeigen:

1. Klicken Sie im linken Fensterbereich der Anwendung WImAdmin auf das Zeichen + neben dem Li-
zenzmanagerserver.

2. Klicken Sie auf das Zeichen + neben Clients. Die Clients, die die Lizenz fiir gleichzeitig angemeldete
Benutzer nutzen, werden aufgelistet. Wenn keine Clients aufgelistet werden, verwendet kein Benutzer
die Lizenz fiir gleichzeitig angemeldete Benutzer.

3. Wihlen Sie einen bestimmten Client aus, um anzuzeigen, ob der Client eine Lizenz ausgecheckt hat.
Uberpriifen Sie nach der Auswahl den Bereich "Detaillierte Informationen" im rechten Fensterbereich.

Konfigurieren von Lizenzreservierungen

Sie konnen eine Reservierungsdatei erstellen, in der angegeben wird, wie viele Lizenzen fiir bestimmte
Benutzer oder Benutzergruppen reserviert werden. Die Benutzer werden durch Netz-IDs oder Compu-
ternamen (nicht durch IP-Adressen) identifiziert. Sie konnen zum Beispiel eine Reservierungsdatei einrich-
ten, mit der die Lizenz fiir eine Gruppe von Hauptbenutzern reserviert wird. Fiir diese Benutzer werden
die Lizenzen immer verfligbar sein. Mithilfe der Reservierungen kénnen Sie auch verhindern, dass be-
stimmte Benutzer einen Zugriff auf die Lizenz bekommen.

Erstellen einer neuen Reservierungsdatei
1. Waibhlen Sie die folgenden Befehle aus den Meniis der Anwendung WImAdmin aus:
Edit > Reservation File
Dadurch wird die Anwendung Wlsgrmgr geoffnet.
2. Wahlen Sie die folgenden Befehle aus den Meniis der Anwendung Wlsgrmgr aus: File > New.

Hinzufliigen von Lizenzen und Benutzer zur Reservierungsdatei

1. Waibhlen Sie die folgenden Befehle aus den Meniis der Anwendung Wlsgrmgr aus:
Feature > Add

2. Klicken Sie im ersten Bildschirm des Assistenten auf Weiter.

3. Geben Sie den Funktionscode fiir die entsprechende Lizenz an, die Sie reservieren mochten. Informati-
onen zum Abrufen der Funktionscodes fiir die entsprechenden Lizenzen finden Sie unter
lder Details zu einer Lizenz” auf Seite 15| Legen Sie aufierdem eine bestimmte Version fest. Geben Sie

18 IBM SPSS Statistics Version 22: Lizenz fiir gleichzeitig angemeldete Benutzer - Administratorhandbuch



die Version hierbei so ein, wie sie in der Anwendung WIAdmin angezeigt wird (z. B. 160). Die Versi-
on ist nicht optional. Ignorieren Sie die Steuerelemente fiir "Capacity", weil Lizenzen dieses Typs nicht
unterstiitzt werden.

Klicken Sie auf Weiter.

Geben Sie fiir die Gruppe von Benutzern einen Namen an. Der Name ist willkiirlich, er sollte jedoch
aussagekréftig sein (z. B. Vertrieb).

Geben Sie die Anzahl der Lizenzen an, die fiir diese Gruppe reserviert werden sollen. Die Gruppen-
mitglieder konnen auf alle Lizenzen zugreifen. Die Anzahl von Lizenzen, die Sie angeben, steht je-
doch nicht mehr fiir die Benutzer zur Verfiigung, die nicht Mitglied dieser Gruppe sind. Dies bedeu-
tet: Wenn Sie von 10 Lizenzen 5 Lizenzen reservieren, konnen Mitglieder dieser Gruppe iiber 10
Lizenzen verfiigen, wihrend den anderen Benutzern nur 5 Lizenzen zur Verfiigung stehen.

Klicken Sie im Fenster "Members" auf Add, um einen der Gruppe zugehorigen Benutzer oder Compu-
ternamen (keine IP-Adressen verwenden) anzugeben. Benutzer und Computer, die der Gruppe ange-
horen, konnen die reservierten Lizenzen verwenden. Benutzer und Computer, die der Gruppe nicht
angehoren, kénnen nicht auf die reservierten Lizenzen zugreifen. Geben Sie so viele Benutzer und
Systeme wie erforderlich an. Beachten Sie, dass sich die Gruppen gegenseitig ausschliefSfen miissen.
Daher konnen verschiedenen Gruppen fiir dieselbe Lizenz nicht dieselben Benutzer oder Computer
enthalten.

Klicken Sie auf Fertigstellen, wenn Sie der Gruppe alle Benutzer hinzugefiigt haben.

Fiigen Sie nach Bedarf weitere Gruppen oder Lizenzen hinzu. Sie kénnen Lizenzen und Gruppen
auch dndern oder 16schen, indem Sie auf diese mit der rechten Maustaste klicken und die Option Pro-
perties auswéhlen.

Speichern der Reservierungsdatei

1.

4.

5.

Waihlen Sie folgenden Befehle aus den Meniis aus, wenn Sie die Reservierungsdatei fertiggestellt ha-
ben:

File > Save As

Speichern Sie die Datei an einem leicht zugéanglichen Speicherort. Im nédchsten Schritt miissen Sie die
Datei kopieren.

Um die Einstellung zu aktivieren, dass der Lizenzserver die Datei Isreserv beim Start automatisch fin-
det, kopieren Sie die Datei unter Windows in den Unterordner winnt im Lizenzmanagerinstallations-
verzeichnis. Wenn Sie den Standardspeicherort akzeptiert haben, wechseln Sie in den Ordner C:\
Programme\IBM\SPSS\Concurrent Licensing Tools\<Version>\License Manager. Auf anderen
Betriebssystemen kopieren Sie die Datei direkt in das Lizenzmanagerinstallationsverzeichnis.

Wenn Sie allen redundanten Servern dieselben Reservierungen zuweisen mochten, kopieren Sie die
Reservierungsdatei (Isreserv) auf jeden Server.

Starten Sie abschlieflend jeden Lizenzmanager neu.

Starten und Stoppen des Lizenzmanagers
Die Methode zum Starten des Lizenzmanagers hingt von Ihrem Betriebssystem ab.

Windows

Auf Windows-Computern wird der Lizenzmanager als Systemdienst ausgefiihrt. Der Dienst wird stan-
dardméflig automatisch gestartet. Falls Sie ihn dennoch einmal manuell starten miissen, gehen Sie wie
folgt vor:

1.

2.
3.
4.

Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung,.
Doppelklicken Sie auf Dienste.
Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.

Klicken Sie mit der rechten Maustaste auf den Dienst und wéhlen Sie die Option Starten oder Been-
den aus.
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Andere Betriebssysteme

Auf anderen Betriebssystemen wird der Lizenzmanager als Damonprozess ausgefiihrt. Fithren Sie zum
manuellen Starten die folgenden Schritte aus. Sie kénnen den Lizenzmanager auch zum automatischen
Starten konfigurieren (Anweisungen folgen).

1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.

2. Starten. Geben Sie als Root an der Eingabeaufforderung ./1serv & ein und driicken Sie die Eingabe-
taste.

3. Beenden. Geben Sie als Root ./1srvdown <Hostname> an der Eingabeaufforderung ein, wobei <Hostna-
me> der Netzname des Computers ist, auf dem der Lizenzmanager ausgefiihrt wird. Driicken Sie
dann die Eingabetaste.

Konfigurieren des Lizenzmanagers fiir den automatischen Start
Windows

1. Doppelklicken Sie in der Windows-Systemsteuerung auf Verwaltung.

2. Doppelklicken Sie auf Dienste.

Suchen Sie in der Liste der Dienste die Option Sentinel RMS License Manager.

Klicken Sie mit der rechten Maustaste auf den Dienst und wéhlen Sie die Option Eigenschaften aus.
Legen Sie als "Starttyp" Automatisch fest.

Klicken Sie auf OK.

ook w

Andere Betriebssysteme

1. Figen Sie einer der Startdateien des Betriebssystems den Eintrag ./1serv & hinzu.

Deinstallieren des Lizenzmanagers

Windows

1. Waihlen Sie folgende Befehle aus dem Menii "Start" von Windows aus:
Einstellungen > Systemsteuerung

2. Doppelklicken Sie auf Software.

3. Waihlen Sie den Eintrag IBM SPSS Concurrent Licensing Tools - License Manager aus und klicken
Sie dann auf Entfernen.

4. Klicken Sie auf Ja, wenn Sie aufgefordert werden, den Lizenzmanager zu entfernen.
5. Wahlen Sie Sentinel RMS License Manager und klicken Sie anschlieSend auf Entfernen.
6. Klicken Sie auf Ja, wenn Sie aufgefordert werden, den Lizenzmanager zu entfernen.

Andere Betriebssysteme
1. Wechseln Sie an der Eingabeaufforderung in das Installationsverzeichnis des Lizenzmanagers.

2. Beenden Sie den Lizenzmanager, indem Sie als Root an der Eingabeaufforderung ./1srvdown
<Hostname> eingeben, wobei <Hostname> der Netzname des Computers ist, auf dem der Lizenzmana-
ger ausgefiihrt wird. Driicken Sie dann die Eingabetaste.

3. Loschen Sie das Installationsverzeichnis des Lizenzmanagers.

Deinstallieren des Lizenzmanageradministrators

Windows

1. Wabhlen Sie folgende Befehle aus dem Menii "Start" von Windows aus:
Einstellungen > Systemsteuerung

2. Doppelklicken Sie auf Software.

3. Waihlen Sie den Eintrag IBM SPSS Concurrent Licensing Tools - License Manager Administrator aus
und klicken Sie dann auf Entfernen.
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4. Klicken Sie auf Ja, wenn Sie aufgefordert werden, die parallelen Lizenzierungstools zu entfernen.

Andere Betriebssysteme

1. Loschen Sie das Installationsverzeichnis des Lizenzmanageradministrators.

Fehlerbehebung bei Problemen mit den Desktop-Computern

Gehen Sie folgendermafien vor, wenn die Desktop-Computer der Endbenutzer den Lizenzmanager nicht
finden konnen:

1. Fiihren Sie 1swhere aus, um zu iiberpriifen, ob der Desktop-Computer den Netzcomputer finden
kann, auf dem der Lizenzmanager ausgefiihrt wird. Weitere Informationen finden Sie im Thema
|,,Ausf1'ihren von ”Iswhere"”l

2. Vergewissern Sie sich, dass der Lizenzmanagerservice auf dem Netzcomputer ausgefiihrt wird.

3. Uberpriifen Sie die entsprechende Datei spssprod.inf. Unter Windows befindet sich diese Datei auf dem
Desktop-Computer im Installationsverzeichnis des Produkts. Unter Mac OS befindet sich diese Datei
im App-Bundle unter Contents/bin. Unter Linux befindet sich diese Datei im Unterverzeichnis bin des
Produktinstallationsverzeichnisses. Offnen Sie die Datei spssprod.inf und vergewissern Sie sich, dass
ftir DAEMONHOST der richtige Name bzw. die richtige IP-Adresse des Computers festgelegt ist, auf dem
der Lizenzmanager ausgefiihrt wird. Wenn Sie redundante Server einsetzen, darf kein Wert angegeben
sein. RedundantServers sollte alle definieren. Die Namen miissen durch Doppelpunkte (:) getrennt
sein. Wenn es sich beispielsweise bei den Lizenzmanagercomputern um SERVER1, SERVER2 und
SERVER3 handelt, wird RedundantServers auf SERVER1:SERVERZ2:SERVER3 gesetzt.

Ausfihren von "Iswhere"
Iswhere kann tiber den Desktop-Computer eines Endbenutzers ausgefithrt werden, um zu ermitteln, auf
welchem Computer der Concurrent License Manager ausgefiihrt wird.

1. Wechseln Sie per Eingabeaufforderung in folgendes Verzeichnis:
*  Windows. <Installationsverzeichnis>
¢ Mac OS. <Installationsverzeichnis>/<Produkt>.app/Contents/bin
e Linux. <Installationsverzeichnis>/bin
2. Geben Sie Tswhere (Windows) bzw. ./1swhere (Linux und Mac) ein.

Service und Support

Um den Technischen Support von IBM zu kontaktieren, rufen Sie fhttp://www.ibm.com/support| auf und
senden Sie eine Fallbeschreibung. Sie miissen sich beim Technischen Support von IBM registrieren, falls
Sie das nicht schon frither getan haben.

IBM bietet aufierdem regelméfig offentliche Schulungsseminare fiir IBM Produkte. Die Ausbildung kann
auch bei Ihnen vor Ort erfolgen. Informationen zu Schulungsseminaren finden Sie unter
lhttp:/ /www.ibm.com /training /spss|
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